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2. EFIS 2.0: Login

21. Logging inwith Go Secure
EFIS 2.0 URL:

https://efis.fma.csc.gov.on.ca/workspace/index.jsp

In order to log into EFIS 2.0, you need a Go Secure account.

If you have yet to register, please follow the instructions in the registration Guide:
(EFIS_User_Registration_Instructions_Final_English).

The EFIS URL above will open the Go Secure login page. Please enter your User ID
and Password.

By clicking on Sign In button, you will be directed into the EFIS 2.0 application.

e
e . Francais
ff“- Ontario

Environment: gdc

( i®SECURE Sign In
LOGIN
: GO Secure ID :
Praviding secure online resources for individuals within the
Ontario and Broader Public Sectors Password :

GO Secure Profile | Don’t have an account?
(See your profile, change password or security questions)

i
GO Secure Login - Delegated Administration

(For administrators of user access and resources) Eorgot your I or pRsswWord?

CONTACT US | A LITY | PRIVACY | HELP

© QUEEN'S PRINTER FOR ONTARIO, 2012 | IMPORTANT NOTICES | ENV ID: GDC SYSTEM ID: 1
LAST MODIFIED: 2014-01-23



https://efis.fma.csc.gov.on.ca/workspace/index.jsp

2.2. Bookmarking the EFIS 2.0 URL

Once you have successfully logged into EFIS 2.0, you can create a bookmark for easy
access.

Follow these steps to create a bookmark:

e #### Rob to create the steps

—— 1 Ml
{8) Oracle Enterprise Performance Management System Workspace, Fusion Edition - Mozilla Firefox ” T T ]

File Edit View History [Bookmarks| Tools Help o —

| { Oracle Enterprise Perfor Show All Bookmarks  Ctrl+5Shift+B

W

€ @ nipsyjtestersi|__ Bookmark This Page Cir-D %7 v & | [+ Googe 2l @

ORACLE Enterprie Subscribe o This Page..

HNavig ares Bookmarks Toolbar

Recently Bookmarked

Recent Tags

Morilla Firefox
PPE

: | 0a

“ PROD

= oev

7 dev

L B®

Unsorted Bookmarks b mecoey
4 MeceTL
4 MeCTEST

Workspace Pages
(=

CRTER R R R I T T e




3. User Set Up

At the beginning of each reporting cycle (the Interim Report and Financial Statements),
you are required to set up your user preferences.

3.1. At the Start of a New Reporting Cycle

Whenever the Ministry releases a new reporting application, is a good practice to clear
your Browser cache. This is done by selecting “clear recent history” from your browser
menu and selecting “clear all”’. Here are the steps for clearing the cache:

e # Rob N: insert screen shots

3.2. Reporting Settings

In order to generate reports, at the beginning of each reporting cycle, you will have to
complete a one- time setup of the “User Point of View”:

When you are logged into EFIS, select File then click on Preferences.

ORACLE Enterprise Performance Management System Workspace, Fusion Edition

Navigate File Edit Miew Favortes Tools Help

Open

Open in Smart YWiew

Close

Save
Prirt

Forn Task List Status
Preferences...

iy Ues Log OFf Task List Status - All

ey Exit

W (ncomplete
M Completz
B Cverdue

Incomplete, 100.0%

Task List Status - All

1. In the popup screen select Financial Reporting on the left hand side.
2. Under Default Preview Mode select PDF Preview.

3. In User Point of View, select “On” and click on Setup Members



Preferences (=] 1

7 Financial Reporting
b

Default Preview Mode Export to Office Application:
EI () HTML Preview Office 2002 ~h|w|
(@) POF Preview
Authentication

@ User Paint of View
= i - Preview
inandal Reporting .
() Off

Q:R]g

i :
Web Analysis I Setup Members... I
Planning Merge Equivalent Prompts
Annotation Print Details. ..
Date Value Format
MMM d, yyyy T
Query Ready Mode
(@) Smart View
() Simple Excel
Help oK Cance|

4. In the resulting Setup User POV pop-up screen, click on the Database
Connection dropdown.

5. For database connections, select the corresponding reporting cycle and then
click "Refresh’.

a. For example, the name of the application is: F1415FIS_Planning_Main.

o it SCREEN better screen shot — Rob N

Setup User POV EY

Select a Database Connection and then select the members you want to be available to you when using the User Point of View.

Database Connection: P1415FSP_Planning_Main + Refresh

After you have selected the correct database, it is important that you make the following
selections and click Apply:

e For all dimensions, select: All Members
e For “Display Member Label as”, choose: Default
e For “Dimension Labels are”, choose: Included

e For “Member Selection Displays”, select: Only Members | Can Access



I Setup User POV

Select a Database Connection and then select the members you want to be available to you when using the User Point of View.

Database Connection: P1415FSP_Planning_Main + | Refresh
Cimension Choices List
Account All Members “ all
Period All Members “ All
fear All Members “ all
Scenario All Members “ All
Version All Members “ all
Redpient All Members “ All
Category All Members “ All
SubCategory All Members “ All
I
Display Member Label as: Default -
Cimension Labels are: Induded -
Member Selection Displays Only Members I Can Access
anning datasources,
Help OK | Cancel  Apply ()

e Click Apply to save your changes.
e Click OK to close the Setup User POV dialog.

e Click OK to close the Preferences dialog.

3.3. Display Options

Once you open a form for the first time to enter data, you should also set your display
preferences. To set your display preferences, please select: File then click on

Preferences.
On the Preferences screen:
1. Click on Planning
2. Then select Display Options

3. Select the desired Number Formatting from the dropdown list:




e Thousands Separator - Comma
e Decimal Separator — Dot
¢ Negative sign — Paraenthesis
e Negative Color — black
4. First click on Save and then click OK to save your changes.

o ### Rob N — new screen shot to show the last 2 steps

Preferences %]
~—| Application Settings I Display Options \IPnnting Options  User Variable Options
|
Number Formatting gt
General
Thousands Separator Comma |v | []
a Decimal Separator Dot v | [
Authentication Negative Sign Parentheses |v|[]
Megative Color Black v | [
gﬁ Page Options UUse Application Default [
Financial Reporting Remember selected page members Yes v | []
. Allow Search When Number of Pages Exceeds 100/ []
1 Lol Indentation of Members on Page Indent based on hierarchy  |v| []
Web Analysis Other Options Use Application Defautt []
’ Show consolidation operators Form Setting | w | [
-l Warn if form larger than cells specified so00| ]
Planning UI Themne Normal v
Text Sze Normal v
Date Forrmat YYYY-MM-DD v O | L
H
Save Reset
Help oK Cancel

3.4. Setup your Home Page

You can setup a home page to quickly access your applications.
e Select File > Preferences > General

e From the content dropdown select Home Page then OK.



Preferences 3]

- Default Startup Options
o
= Content:
General Home Page =
Authentication
e

| Show Path For Documents
Financial Reporting

= Your e-mail address:

lb{(‘g al.mclaren@manageflow.com
Web Analysis Accessibility Mode
& Select Therne:
Planning Normal =

— —

3.5. Change Language ### REMOVE the change language section

3.5.1. Firefox

Firefox users can change the Firefox page display to French Language by selecting,
Tools > Options

File Edit View History Bookmarks | Teols

i i Oracle Enterprise Performance Mana Downloads Ctrl+)
Add-ons Ctrl+5Shift+ A
= | g https://test.efis.fma.csc.gov.o Set Up Sync...
ORALCLE Enterprise Perfor Web Developer ’
Page Info
Monitor with Eiddler 4

Start Private Browsing  Ctrl+ Shift+P
Clear Recent History... Ctrl+5Shift+Del

I Options I

User Name:

In the Options Screen in the Language section select the Choose button,
French/Canada from the Language dropdown list, select Add then Select OK. You will
need to restart the browser for these setting to take effect.



=y - :

e
General Tabs Content  Applications  Privacy  Security Sync Advanced

[T Block pop-up windows Exceptions...

i
Load images automatically
Enable JavaScript Advanced...
e L 2201214 -
Languages [ ‘

Fonts & Colors

|| Defauitfont: | Times NewRoman o Web pages are sometimes offered in mare than one language.

Choose languages for displaying these web pages, in order of
preference,

Languages in order of preference: -

Languages English/United States [en-us] Move Up

English [en]

Choose your preferred language for displaying pages

IFrencm’Canad.a [fr-cal = I Add I
| |

[ ok

g
5
3
o
Iz
iy
=

3.5.2. IE

IE users can change the |IE page display to French Language by selecting, Tools -
Internet Options

File Edit View FavoritesHEIp

Delete browsing history... Ctrl+ Shift+ Del
InPrivate Browsing Ctrl+Shift+P

Tracking Protection...

ActiveX Filtering

Diagnose connection problems...
Reopen last browsing session

Add site to Start menu

View downloads Ctrl+]
Pop-up Blocker r
SmartScreen Filter 3
Manage add-ons GO Secure D :
Compatibility View Ontario o
Compatibility View settings Password -
Subscribe to this feed...
Feed discovery » pns. I Sign In
Windows Update
Forgot your ID or |

F12 devel tool

R kv Don't have a GO §
Fiddler Register Now.

OneMote Linked Notes
Send to OneNote

I Internet options I © QUEEN'S




In the General Screen select Language and then add French/(Canada)[fr-CA] from the
Language dropdown list then Select OK. You will need to restart the browser for these

setting to take effect.

~—
Intemnet Optiens

GO SecureLogin Language Preference
General ISecunty | Privacy I Cantent I Cannections | Pragrams I Advanced‘ T
Home page Language Preference " S Language Preference B
Add the languages you use to read websites, listing in order of
./? To create home page tabs, type each address on its own line, preference, Only add the ones you need, as some characters can &l
Rt 11 s Tma csc.gov.on.ca/workspace/indexjs p DS Lepniems seliorie be used to impersonate websites in other languages.
Add the languages you use to read websites, listing in order of
preference. Only add the ones you need, as some characters can Language:

be used to impersonate websites in other languages. = = 12) [ CA]
English {United States) [en-Us]

[French (Canada) [ CA] ]
[ Use current ] [ Use default ] [ Use blank ] Language:
Move down
Browsing history English {United States) [2n-US] Mave up
,-

\ Delete temporary files, history, cookies, saved passwords,
¥ and web form information.

Delete browsing history on exit

Delete... Settings Add... Prefix and suffix options

- [] Do not add "www!' to the beginning of typed weh addresses

Search

.F\ Change search defaults. Prefix and suf Add Language Specify the suffix (for example .net) that should be added to
fj ["] Do not ade typed web addresses when you press Ctrl + Shift + Enter.
Language:
Tabs Spedify the su Engish feri Suffix:

. : -
Change how webpages are displayed in typedwebad | | Eoyian (Estonia) [t-£5]
tabs. suffix: Estonian [et]

Faroese (Faroe Islands) [fo-FC]
Faroese [fo] —

Cancel

A
ppearance Filiping {(Philippines) [fil-PH] ™
[ coors JI[ tenguages ||| Fonts | [ accessbmry | | L Emﬁ%andy [

Finnish [f]

ch (B=loium' (fr B
[FenchCoram e

French (Luxembourg) [fr-U]

“ French (Monaco) [T-MC) =

ARIO, 2012 | IMPORTANT NOTICES | ENV ID: GDC SYSTER

CONTACT US | ACCESSIBILITY | PRIVACY | HELP User defined:
LAST MODIFIED: 2014-

3.5.3. Set Language in Planning

To set the Language in Planning, go to File > Preferences. Select Planning on the
Preferences screen select French as the Alias setting, select Save then Select OK.
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Help

General

a

Authentication

el

Financial Reporting

!

Web Analysis

Planning

Display Options

Printing Options

User Variable Options

E-mail Options
E-mail Address
Task List Notification
Approvals Motification
Copy the Application Owner

Job Console Notification

Alias Setting
Alias Table

Approvals Options

Show Planning Units as Aliases

Show Planning Units That are Not Started

Out of Office Assistant

Select
Action
Select
Mext
Owner
Enter
Annotation

Use Application Default [ =

No ||
Yes E“:‘
No E“:‘
ves 7| [l
Use Appli
French E“:‘
Use Application Default []
Yes E“:‘
No [=][]

Tam currently out of the office. [[]

m

Promote

<Automatic>—

< n

Save | Reset




4. Planning Navigation

4.1. Selecting an Application (Doc Set)

An application in EFIS 2.0 can be opened using one of the following methods:

1. Using the Menu Bar, select: select:

Navigate - Applications - Planning - application name OR select, File >

Open - Applications - Planning - application name

### SCREENS

R e
@ Cracle Enterprise Performance Management System Workspace, Fusion Edition - Mozilla Firefox
— - - .

File Edit View History Bookmarks Tools Help

| { | Oracle Enterprise Performance Manage... | 4| — — ———

6 @ https://test.efis.fma.csc.gov.on.ca/workspace/index.jsp

ORACLE Enterprise Performance Management System Workspace, Fusion Edition

Navigate File View

Favorites Tools Help

&l Applications » 4 Planning » 4 FSTESTS
1'1_*'_:] Explore Refresh 4 MARDEV
Workspace Pages 4 4 P1415FSP
ePage
&7 Administer b & 5131413
Open Items 3 by _ 4 sl L e
e & 513143 d Quick Links
&b PL415FSP a4 513142 Favorites
FSTEST3
2 # surEx Applications
&P S1415Rd2 § ioes
% Open... Planning
& 5131915
- % FSTEST3

— —
@ Cracle Enterprise Performance Management System Workspace, Fusion Edition - Mozilla Firefox '
- - - - -

Eile Edit View History Bookmarks Tools Help

| ("} Oracle Enterprise Performance Manage... | 4 |—— S — —

+ & hitps://test.efis.fma.csc.gov.on.caworkspace/indexjsp

ORACLE Enterprise Performance Management System Workspace, Fusion Edition

Mavigate [Eile| Wiew Favorites Tools Help
2 3 Document. .. Ctrl+0
A e Open L
Cloze Workspace Pages 4

Home Preferences... URL...

fShare Log Off & applications v 4 Planning » 4 FSTEST3
_Bat ] Refresh g maroEY
J » N & PiaisFse —
| D e e Quick Links
a
4 P1415FsP cmes e
FSTEST3
£ & 513142 kations
4 S1415Rd2
£ Open... b S1314E2c Ining
Al mamaamma




An alternative way to open applications in EFIS 2.0 is:

2. Using the Home Page: The application can be selected from either the Recently
Opened list or the Quick Links.

HomePage *

/Shared Workspace Pages/HomePage

i Recently Opened . ! A\i/Quick Links

o P1415FsP Favorites
M FSTEST3 S
Applications
& 51415R.d2
% Open... Planning
o FSTEST3
A MARDEV
4 P1415FSP
51314618 More ¥

| Lril Workspace Pages |

Once you select the correct Application using one of the above methods, the My Task
List will be displayed.

ORACLE

Navigate File Edit vien [FauSHEES] Tools Help

Logged in as EFIS. TRAINERO1@GMAIL.COM | Help | Log OFF

A e 0 Explore

-
sezrch [N © :-v=rd
Forms Task List Status
My Task List Task List Status - All View
= B submission Input and Query_Soumission Entrée
I submission tnput and Query
B soumission Entrée etrequéte
= B Subisclon Menagement - Madifer Gestion cela . W incomplete
B submission Management M Complete
1 Gestion de Ia soumission (et
Incomplete, 100.0%
Task List Status - All
“
Task List Tasks - All
Task. [Type Status Due Date Alert Completed Date | Instructions
=] {7 Submission Input and Query_Soumission Entrée et requéte (5] =]
|5 9 5ubmission Input and Query ':@ @
El #Input and Results E} =]
(@Data Elements (e} =]
5/ Operational Support —Program Staff [} =]
(5 Administration - Program Staff (e =]
W Expenditures & [#]
@ B c &Entitement 3 7]
Preferences e a = =

4.2. EFIS 2.0 Task List

The Task List allows you to access all forms, reports and workflow activities that are
available to your user type. The Task List has been organized for you to follow a
suggested order of data input.



You can drill down into lower levels of the Task List to reveal additional detais and

schedules.

The Task List, when fully expanded, is grouped into ‘Input and Results’, ‘Reports’,
‘Validation Formats’ and ‘Submission Management’ folders.

#H# SCREEN

Fusion Edition

ORACLE' taterprise per

Navig Favorites| Tools Help

Logged in as EFIS. TRAINERO1@GMAIL.COM | Help | Log OFF

-
search | © =
Forms Task List Status
My Task List Task List Status - All View -
5 B submission nput and Query._Soumission Entrée
B2 submission Input and Query
] jor Entric et requate
= s Management - Modifier_Gestion de |a . M Incomplete
¥ Submission Management M Complete
2 Gestion de Ia soumission  Overdue
Incomplete, 100.0%
Task List Status - All
«
Task List Tasks - All
[Task [Type Status Due Date Alert Completed Date | Instructions
51 2 submission Input and Query_Soumission Entrée et requéte = ]
= [ Submission Input and Query 7]
B §2Input and Results = 7]
fpData Blements & @
(s Operational Support — Frogram Staff (] =]
@ Administration - Program Staff [F3 ]
(@ Expenditures [ o
P I, .. G (Enttement [=]] ]
Preferences T s =N =

ORACLE’

Navigate File Edit View Favorites Tools He

Logged in 25 EFIS.TRAINEROIEGMALL.COM | Help | Logoff O

_—

Forms Task List Status o
My Task List Task List Status - All View v
= ' submission Input and Query_Soumission Entrée
&) I submission Input and Query
F 1put and resuits
HReports B incomplete
P M Complete
M Overdue
Incomplete. 100.0%
Task List Status - All
Task List Tasks - All
o [Task [Type [status Due Date Alert |Completed Date _[Instructions [action ||

4.2.1. Expand and Collapse Task List

The Task List is organized into folders that contain cubes. To expand the folders, right-
click on afolder and select Expand. Alternatively,click the [+] box next to the folder. To
expand one level of folders select Expand. To expand all the folders below the selected
folder select Expand All Below. To access the Task (Form, Report, etc.), click on the

cube icon.

In the screenshot below, the right arrow points to an example of the folder Icon and the

left arrow points to an example of the Cube Icon.



### SCREEN

[ Forms

My Task List

=1 [ Submission Input and Query_Soumission Entrée et requéte i

= P Submissiop lmput and Guery

Data Elements

S Operational Support - Program Staff
5 Administration - Program Staff

& Expenditures

5 Entilement

m

[ Errors and Warnings
& Program Locations

2] Ej Renarte

4e) 8 Dt ksl boms ey o o e spcalertoe ot v | [ M- Geoge IS

Task List Status
Task List Status - Submission Input and Query Saumissian Entrée ot requite Yew w
0 P T — RSP TRRI aiue of o Todk U

pie 2 soumsman Mgl

Task List Tasks - Submission Tnput and Query_Soumission Entrée of requite
Task Type Stahs Due Date Mert |Completed Date Instruchiors
e ————— i f8 EWl L LR B N 5
=l [ Submeson lnpust and Query
=i Pineut snd Resits
fyiData tlements
3t Operational Support = Program Stalf
g tbrarsnte i - Brogy e Stal!
“wExpendtres
L] r rplEnntement

Al I el - 8

This is an example of right clicking on a folder and selecting Expand to drill down the
selected item to the next level.
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ORACLE enterprise Performance Management System Workspace, Fusion Edition

File  Edit

A= Explore

Forms

My Task List

= iission Input and Query. issi
2 B submission Input and Query

B 1nput and Results

P Reports

I vaiidation Formats

‘Soumission Entrée et requéte |

I submission Management - Modifier_Gestion de | soumission - Modifi

J sk List Status

Task List Status - Submission Input and Query_Soumission Entrée et requéte

ée etrequetll status of all TaskLists

Incomplete, 100.0%

Task List Status - Submission input and...

Task List Tasks - Submission Input and Query_Soumission Entrée et requéte

B incomplete
M Complete
M Overdue

View +

[Task [Type Status Due Date Alert Completed Date | Instructions Action
= [ submission Input and Query_Soumission Entrée &'|[i5] @
= [ Submission Input and Query 3 =]
= [ Input and Results = =]
fpData Elements [} [=]
{s¢# Operational Support - Frogram Staff [} =]
fe Administration - Program Staff |E =]
(@ Expenditures (e} @
.‘ ; : E 2
Preferences =w=T oty lii]

This is an example of right clicking on a folder and selecting Expand All Below will drill
down the selected item to the next level.

ORACLE" Enterprise Performance Management System Workspace, Fusion Edition

Edt v

# e O Bl

Forms

My Task List

= P iission Input i trée et req "~

= B submission Input and Query
& P 1nput and Results
¥ Data Elements

m

¥ Cperational Support — Program Staff
BP Administration - Program Staff
¥ Evpenditures
¥ Entitlement L3
5 7 rrors and Warmings
& \Warnings
O e

Jresk st status

Task List Status - Submission Input and Query_Soumission Entrée et requéte

Status of all Task Lists

Incomplete, 100.0%

Task List Status - Submission Input and...

Task List Tasks - Submission Input and Query_Soumission Entrée et requéte

W Incomplete
W Complete
H Overdue

View -

- Task } [Type Status |Due Date Alert CompletedDate | Instructions
™ (=] {7 Submission Input and Query_Soumission Entrée e[ [i5] [7]
& P Reports
P £ {Submission Input and Query [E2 @
Cericats = [ Input and Results = @
¥ Famiy Support Pragrams - Data Elements G#Data Elaments = 7]
59 Family Support Programs — Operational Support - Prog & Operational Support — Program Staff |0y 7]
9 Family Support Frograms — —Program S & Adnministration -Program Staff 3 7]
9 Family Suoort Proarams - Adiusted Gross Expenditur ™ 5 & 7]
al ] v ; % 7]
Preferences L ear e \Ldacri = [l

m

Right clicking on an expanded folder in the Task List and clicking Collapse or the [-] box
next to the folder to collapse one level or click Collapse All Below will hide all of the
levels below the selected folder.
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@ Oracle Enterpri Manag
- —
File Edit View History Bookmarks Tools Help

| Oracle Enterprise Performance Mansge.. | +| "

System Warkspace, Fusion Edition - Mozilla Firefox
- —

€ B httpsi//test fis.fma.csc.gov.on.ca/workspace/index.jsp
ORACLE’ enterprise System Work Fusion Edition

Faw

v v @ | |2~ Google

jed in as EFIS, TRAINERO 1 OM | Help |

-

Forms | rosk List status

My Task List

Task - Submission Input and Query "

Task Instructions ™.

v

F] r "
= ¥ submission Input and Query_Soumission Entrée et requéte Status Incomplete

=8 2"“‘] G Completed Date
2 Fmp T Complete No
o Duc Date
Collapse All Below =
&g

9 Entitement
[S] T—— Wiarnings

& armings
 Errors
& program Locations
8 P Reports
O Certificate
& Eamily Support Programs - Dats Elements
&9 Family Support Programs - Operational Support — Proc

mn

& Eamily Support Programs — —Program 5 ~
O n v

Preferences

Complete

Previous Incomplete || Erevious | NextIncomplete | Next | TaskListHome

Example of selecting Collapse.

ORACLE enterprise Pefformance Management System Workspace, Fusion Edition

P1415FSP - Task List Status *

Dl eaEE S S O

EN 'R

Task Input and Query | Tack Instructions "

Forms Task List Status

My Task List

= ¥ suiomission Inout and Query_Sauission Entrée et requéte ST
= F[Submission Input and Query| Completed Date

B nput and Resuls Complete Mo
P Reports Due Date

alidation Formats ;

1 Soumission Entrée et requéte

Y 5. bmission Management - Modifier_Gestion de la soumission - Modfi

Example of selecting Collapse All




Navigate Fle Edit View Favortes Tools Help

P1415F5P - Task List Status *

Fusion Edition

Logged in as EFIS. TRAINERO1GGMAIL.COM | Help | Log 0ff ©

-_—

Forms

My Task List

Task List Status

Task - Submission Input and Query .. Task Instructions

B submission Management - Modiifier_Gestion de la soumission - Mocif

el ission Input and Query. ission Entrée et requétll

4.3. How to Navigate in Planning using Task List

Completed Date
Complete No
Due Date

Status Incomplete

m

To expand any form in EFIS 2.0 Task List, click on the Expand icon [+] next to the
desired Task List item. A list of folders/cubes for each area will be displayed. The ‘Input
and Results’ folder contains all the data input forms. The ‘Reports’ folder contains
reports for all Schedules and other EFIS2.0 reports. The ‘Validation Formats’ folder
contains valid (allowable) data formats for all input forms. The ‘Submission
Management’ folder contains all the tasks related to validation and promotion of your

EFIS 2.0 submission.
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£ Forms
My Task List

Task List Status
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3l Preferences
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4.3.1. Input and Results Data Navigation

All data input forms are contained in the ‘Input and Results’ folder. To access the
individual forms, expand the ‘Input and Results’ folder.
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4.3.1.1. Errors and Warnings Navigation - Input

The Errors and Warnings have been separated into 2 input forms, one for errors and
one for Warnings. The ‘Warnings’ form now includes a new field for Warning
Explanations where you must enter an explanation for any warning messages that have
a “Yes” value. (This replaces the additional excel report that was previously required.) A
new Errors form prohibits the submission your file to the Ministry if there are any errors
and/or if explanations have not been provided for your warnings.

Example of Warning Explanation Form
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The ‘Error’ form now has a new ‘Recipient Accepted Error Confirmation’ dropdown that
allows submission with outstanding errors as part of the Submit with Errors process.
This functionality can only be used after consulting with the Ministry



If an explanation for a warning has not been provided, an ERROR will be generated in

the Error form.

ORACLE'

ise Performance

P1415FSP - Task List Status ¥

System Workspace, Fusion Edition

Logged in as EFIS.TRAINERO1@GMAIL.COM | Help | Log OFF ‘©

-

Forms

My Task List
5 B Submission Input and Query_Soumission Entrée
B B submission Input and Query
& B tnput and Results
¥ Data Blements
i & Operationsl Suppart - Program Staff
Administration - Frogram Staff
¥ Expenditures
9 Entitement
& # Erors and warmings
 Warnings
& Errors

& program Locations
P oepors
B validation Formats
¥ Soumission Entrée et requéte

B submission Management - Modifier_Gestion de la

) F——— »

Preferences

Task List Status

Task - Errors-Errors | Task Instructions

ElErrors
&,scenario: Financial Statements #Period: YearTotal1 [ vear: 2013-15
|+ [Redpient Working Version - [+
Errors
Value1 value2 Is Error | Board Accepts Error EW Description - En
Indicates if 2
Mo Category No SubCategory No /Non | N /MNen = thereisany
Total L
Mo Category Eror 5C2.9.1 22,912 | No [Mon Administration 3
For the following
A386 - Delivery Agent - Resource Centres | Error_5C2.9_2 0 | Mo [Mon detai code,
For the following
A387 -Resource Centres -FirstNation | Error_SC2.9_2 0 | No [Non detal code, F
For the following
A462 - Ontario Early Years Centres Error_5€2.9_2 0 | Mo /Mon detai code,
For the following
A%66 -Data Analysis Coordinators Error_5C2.9_2 0 | No [Mon detal code,
For the following -

Complete [_] | Previous Incomplete

Previous

Next Incomplete

n

Next || TaskListtome ||

Tips

To view the full description of the Error or Warning, click and hold the bottom-right
triangle of the cell, and drag the cell down to expand.

##tt Rob N to enter screen shot

4.3.2. Reports Data Navigation

Reports that display your input and results for each form are found under the Reports
folder. Reports have been grouped by Schedules and Errors and Warnings. To print a
complete set of reports, select the Report Book folder.

Example of the Report Area folders
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Each of the input cells requires valid (allowable) data formats to be entered before the
data can be saved to the system; the Validation Formats folder contains validation
forms for each input form.
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The chart below provides a listing of all input formats.

Description

Format Code

Non-Input Cell

Blank Cell

Non-Input Cell

Non-Input / Pas d'entrée

All Values, No Decimal

+/-0

Positive Values, No Decimal

+0




Description Format Code
Negative, No Decimal -0

Positive One Decimal +0.0
Negative One Decimal -0.0

One Decimal +/- 0.0
Positive Two Decimals +0.00
Negative Two Decimals -0.00

Two Decimals +/- 0.00
Positive Three Decimals +0.000
Negative Three Decimals - 0.000
Three Decimals +/- 0.000
Positive Four Decimals +0.0000
Negative Four Decimals - 0.0000
Four Decimals +/- 0.0000
Positive Five Decimals +0.00000
Negative Five Decimals - 0.00000
Five Decimals +/- 0.00000
Positive Six Decimals + 0.000000
Negative Six Decimals - 0.000000
Six Decimals +/- 0.000000

4.3.3. Submission Management Navigation

The Submission Management folder includes tasks that are used to perform Version
Management and Promotion activities (to promotethe Recipient Working Version to the
Recipient Active Version). The Version Description and Summary form allows you to
enter a description for the version you are currently working on, as well as keep track of
the activities on different versions in the application.

Example of the Version Description and Summary form
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5. Data Input

5.1.

Data Input and Results — Forms

All data to be entered into EFIS 2.0 is entered using the data input forms. As described
above, each section has a form or set of forms with cells for data input.

e White Cells are data input (you are allowed to enter data into these cells)
e Grey Cells are non-input cells (you are not allowed to enter data into these cells)
e Red Cells indicate a data validation error

The section below explains how to input data into EFIS 2.0.

5.1.1. Opening a Form

To open a Form in the Task List, click on the name of the form.
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EFIS 2.0 displays the form for the task on the right side of the screen.

5.1.2. Enable Input Field

Input fields have a white background. To enable (or activate) an input field for input,

click in the cell.
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To move between cells, you can use your mouse or the following keys on your

keyboard:

e Tab — to move horizontally from the selected cell over to the next cell

e Shift + Tab — to move backwards horizontally from the selected cell to the

previous cell

e Enter — to move to the cell below the selected cell

e Shift + Enter — to move to the cell above the selected cell

5.1.3.

Key in Input Field

Once an input field is enabled (by clicking in the cell), you can enter a value into the cell.
A dialog box will pop-upto show the description of the row and column.

Example of an input field that is enabled with a pop-up description:




@ Oracle E Performance M . Fusion Edition - Mozilla Firefox =
| Oracle Enterprise Performance Manage... | +
€ @ hitpsi//test fis.fma.csc.gov.on.ca/workspace/index.jsp Pl A

ORACLE’ enterprise System Fusion Edition
ate Fle Edit

A & 2 Bl

Forms Task List Status B
My Task List Task - Data Elements-Data Elements - Input . Task Instructions -
] ;
=l El:hmlsslnr\ Input and Query_Soumission Entrée o "= o s
= ¥ submission Input and Query
= EPErmd: YearTotall
= & Input and Results
[+ [Redpient Working version -
© o Recpient Working \ e
Data ments S
Data Elements
&9 Operational Support —Program Staff
& Adrinistration - Program Staff Finandial Statements . |
A386 - Deli it - R Centre
¥ Expenditures eivery Agent -Resource CENTES gy Number by Data Elements Children Served. Column
O ot Rumber by Dats Elements | yigits Made by Parents and Caregivers 234 | | Financial Statements A386 - Delivery Agent - Resource Centres
B £rvors and warnings il Children Served 200 333 i
- P i Visits Made by Children 100 3 |
[ Reports Parents and Caregivers Served 234 3,333 3
B yalidation Formats Famiies Served
P ‘ < Professionals in Workshops and Seminars 2,345 3,434 333
Soumission Entrée et requéts
¥ Submission Management - Modifier_Gestion de s Referrals 33 3,435
Protocols and Official Linkages 456 55 34
Parents and Careaivers in Workshops and Seminars 2,345 4,455 s
‘ I |+
ol i ] 3 L
| T Complete [*] | Previous Incomplete || Previous | NextIncomplete | MNext || TaskListHome

After you enter data into a cell and move to another cell, the system will highlight the
cell in yellow. The cells are highlighted in yellow to help you keep track of the data you
have entered and/or changed.

Once you save the form, the highlights will be removed. Example of a cell highlighted in
yellow:
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5.1.4. Save input field

To save the data you have entered into an input field, click on the Save icon or File >
Save
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After you save the form, the system will confirm that the data has been saved.
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Click on OK to continue.



5.1.5. Invalid Data

When you enter and save data that is invalid (not accepted by the system), the cell will
be highlighted in red and a Data Validation Message will be displayed on the right side

of the form.
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To see the Validation Error message, click on Data Validation Message bar to display

the error message.
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The Data Validation Message will describe the type of error and will provide you with a

link that will take you directly to the cell that contains the error.

In order to correct the error, enter the correct value and save the data. After you have
saved the data, you will get a confirmation message saying that the data has been



saved successfully. Once all the errors on the form have been corrected, the Data
Validation Message will disappear from the the right side of the form..
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If you are not sure what the cell format should be, expand the Validation Formats
folder and open the same form to see the description for each cell.
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& administration - Program Staff Parents and Caregivers in Workshops and Seminars +0 +0
¥ Expenditures H T fiarkrhane Maria Fuants or C 0 3
i | I ]
™ soumission Entrée et requéte -
| T ] b
T I Complete [7] | Previous Incomplete | Previous | NextIncomplete | MNext || TaskListHome

If you enter a non-numeric value into a cell that only accepts numeric values, you will
get an error message and will not be able to navigate away from that cell until it is
corrected.
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My Task List

Task List Status
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¥ Data Elements (3]
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¥ Operational Suppart - Program Staff @ Error:
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B Submission Management - Modifier_Gestion de la Referrals 33 3,435
Protocols and Offical Linkages 456 55 334
Parents and Caregivers in Workehops and Seminars 2,345 4,455 &
Ll i e

Preferences

5.2. Reports

Reports provide you with the results of each form in a report format.

Complete | | Previous Incomplet= || Previous

Next Incomplete

Next | TaskListHome

individual reports or a Report Book that includes all reports.

ORACLE’ enterprise Performance Man
Fie Edt

# fw A Explore

HomePage P1415FSP - Task List Status *

agement System Workspace, Fusion Edition

Users can access

jed in as EFIS. TRAINERO 1@GMAIL.COM | Help | L

L Forms J Task List Status R
My Task List I Task - Input and Results " Task Instructions B
= - [submission Input and Query. ission I

B B submission Input and Query

B [nput and Results

& Prepgrts!

¥ Certficate

&9 Family Support Programs — Data Elemes
¥ Family Support Programs - Operational
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& Eamily Support Programs - Adjusted G
&9 Family Support Programs - Entitlement|
& Warnings
9 Error
 Family Support Programs — Location Scf
&9 Report Book
B yaldation Formats

P soumission Entrée et requéte

B submission Management - Modifier_Gestion de la

Nl i ] v

Status Incomplet
Completed Date
Camplete No
Due Date

m

Preferences

Complete Previous Incomplete || Erevious

Next Incomplete

hext | TaskList Home

Tips

In order to simplify the reports process, you need to perform a simple one-time
Preference set-up at the start of each new reporting cycle. Please refer to Section 3.1

for detailed instruc

tions.




5.2.1. Running a Report

To run a report, select Reports from the Task List.

lanagement System Workspace, Fusion Edition Logged in as EFIS.TRAINERO1GGMAIL.COM | Hel | Log Off ©

-
M P1415FSP - Task List Status * search | AR ©

=/ Forms Task List Status B

My Task List Task - Family Support Programs — Data Elements | Task Instructions
= ' submission Input and Query_Soumission Entrée et requéte

Status Incomplete

& ¥ Submission tnput and Query Completed Date
B Input and Results Complete No
@ Reports Due Date

o Certficate
¥ Family Support Programs — Data Elements |
& Eamily Support Programs - Operational Support — Program &Y

9 Family Support Programs ~ Administration ~ Program Staff
& Fanmily Support Programs - Adjusted Gross Expenditures 4
& Family Support Programs - Entitlement
& Warnings

& Error

m

& Eamily Support Programs - Location Schedule
& Report Book
¥ yaldaton Formats
B soumission Entrée et requéte

B submission Management - Modifier_Gestion de la soumission - Modificatz

< i ] v

® Preferences Complete [7] | Previous Incomplete || Previous || NextIncomplete || Mext | TaskListHome

The Preview User Point of View (POV) screen will be displayed. The first time that
reports are generated at the start of a reporting cycle, you must select a Version and
the Recipient name. (Version: Recipient Working Version, Recipient: The name of your
First Nation) This will become the default setting until you change the Version.

If an error message is displayed prior to the Point of View (POV) screen, check that the
settings in Section 3.1 have been applied.

Preview User Point of View (]

This report/book will run for the members on the user point of view listed
belaw.

Version
Version

Redpient

Recipient

(]

Edit Member Names

_Help _OK | Cancel

To select the Version, click the Select button beside Version to open the version
selection screen, select the version then OK



Though the correct version may already be selected, we suggest unclicking the
button and re-selecting the version to ensure that the EFIS registers the correct
version.

Preview User Point of View

Find: | pame |E| * 4 IilI..ISIE Wildcards
ﬁ‘" | ‘ ﬂ |Ruws Per Page: | 20 E
Mame Default

L @)
Bz @ Version

Eis ™ submission Versions

Redpient Working Version

fe Fl e V10001 Hecdpient Dra

-8 © v10002 Recipient Draft 2

iy @ V10003 Recipient Draft 3

-8 © v10004 Recipient Draft 4

iy B V10005 Recipient Draft 5

iy & V10006 Redpient Draft &

-8 © v10007 Blank Template For Reset
gy & V0ROV Fecdipient FA Viewable Version

"QJ “\1orovDn1 Recipient FA Viewable Draft Version 1

QJ v 1oFovDnz Recipient FA Viewable Draft Version 2

‘-QJ = viorovDo3 Redpient FA Viewable Draft Version 3

To select the Recipient, click the Select button beside Recipient to open the Recipient
selection screen, select the Recipient then OK



Preview User Point of View

Members

Available: Recipient {1-20 of 51) »

Find: Mame |E| = # U:
ﬁi | 'ﬂ 'ﬂ |F‘.ows Per Page: | 20 |E|
Mame Default

B Redpient

E " Total Redpients

]
Q.—i ¥ Ma0003 Algoma DSAB

Once you have made the correct “Point of View” selections, click OK to run the
report.

Preview User Point of View 3]

This report/book will run for the members on the user point of view listed
below,
Version

Recpient Warking Version Select...
Recpient

Algoma DSAB Select...

O Edit Member Names

_Help 0K Cancel

The report will generate in PDF format. You can view, save the file as a PDF or print the
report. The headings on the report will tell you:

e what report you have generated
e the version you are in

e the fiscal reporting year and

e the reporting cycle

### to change screen shot below to reflect a First Nation report



Py

P
fr >Ontario

Submission Version: Recipient Workinag Version

Family Support Programs - Data Elements - Total

Recipient Name: _
Year: 201415
Cycle: Financial Statements

A3B6 - Delivery Agent - Resource Cenfres A4B2 - Ontario Early Years Centres A466 - Data Analysis Coordinators|
Visits Made by Parents and Caregivers 2340 34440
Children Served 2000 3330
Visits Made by Children 200 330
Parents and Caregivers Served 2340 33330
Families Served
Professionals in Workshops and Seminars 23450 34340 333.0
Refermals 330 34350
Protocols and Official Linkages 456.0 550 334.0]
Parents and Caregivers in Workshops and Seminars 23450 44550
Hours of Training, Workshops, Media Events or Conferences 334.0]
Hours of Direct Service
Programs FTEs

@ Error executing query: Y ou are trying to open the
form, but cannot because one of the required
dimensions is not present in the Page. Possible causes
may be that you do not have access to at least one
member of a required dimension, or the member

selection resulted in no members present. Contact vour
administrator. Dimension(V ersion)
com hyperion planning NotEnoughAccessException

Cancel
Tips

If you get the error message above, check that both the Version and Recipient have
been selected.

To change the Version selection without generating the report again, the user can select
the Version screen by selecting the Version tab in the top left side of the report, Select
the new version then select OK. The report will refresh with the new data.
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5.2.2. Generating Report Books

To generate a complete set of reports for all forms, select Reports > Report Book

ORACLE’ enterprise Fusion Edition Logged in as EFIS. TRAIMER( MAIL.COM | Help | Logoff ©

* Forms Task List Status
My Task List

Task - Report Book " Task Instructions B

] 5 7
=1 B submission Input and Query_Soumission Entrée et requéte Status Incomplete

Completed Date
P Input and Resuls Complete No
= P reports Due Date

B Certficate

59 Family Support Programs — Data Elements

2 B submission Input and Query

¥ Famiy Support Programs ~ Operatianal Support  Program 54
9 Family Support Programs — Administration — Program Staff

Family Support Programs — Adjusted Gross Expenditures |

m

9 Family Support Programs — Entitiement
& \yarnings

Error
59 Eamiy Support Programs — Location Schedule
¥ eportBook.
B yaldation Formats
B Soumission Entrée et requéte

9 5.mission Management - Modifier _Gestion de la sounission - Modificats

O il —

* Preferences Complete [C] PreviousIncomplete || Previous || NextIncomplete || Next | TaskListHome

The Preview User Point of View dialog will appear. Select the Version that is to be run
and then select OK to generate the Report Book.

### to change screen shot to reflect First Nation user



Preview User Point of View (%]

This repaort/book will run for the members on the user point of view listed
below,

Database Connection
MCCTEST_Planning_Main -

Version
Recipient Warking Version Select...
Recpient

Algoma DSAR Select...

Edit Member Names

Help oK Cancel
Tips

When creating the Report Book, your planning screen will go blank for some time until
the report is created. During this time, you can perform some other tasks in the Planning
until your report is created.

The report book will generate a Table of Contents in a new tab. You can open a single
report by double- clicking the report ICON () to the left of the report.

Alternatively, you can open all the reports in your submission by selecting File >
Open In > Complete Book in PDF, in the upper tool bar.
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Navigate [Eig] View Favorites Tools He
Open N ..
Open In b @ HTML Preview

=
e TS issi . - search | © -:oncd

Piaie ng:su Complete Bookin POF ghcial Statements
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90003‘ |<|>|

L0 Legoff
M Show Repart

® 5ock Table of Contents: 2015 Family Support Programs Submissian - Financisl Statements
Name Member Selection Report Location

Family Support Programs - Data Elements [P1415FSP fCommon/EN
Family Support Programs - Operational Support — Program Staff /P1415FSP/Common/EN
Family Support Programs - Administration - Program Staff [P1415FSP fCommon/EN
Family Support Programs — Adjusted Gross Expenditures g /P1415FSP /Common/EN
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Errors . /P1415F5P /Common/EN
Warnings = [P1415FSP [Camman/EN
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The full report will be generated as a PDF document with an interactive Table of
Contents. Click on any of the reports listed in the table of contents to open that
particular report.

### To change screen shot to reflect First Nation User
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5.2.3. Opening a report in Excel

Reports that have been generated in PDF can also be exported and saved in an Excel
format. To export a report to Excel, select File > Export > Excel



ORACLE Enterprise Performance Management System Workspace, Fusion Edition

M

Versio

MNew
Open

Open In

Close

Export

rererences... L,

Log Off
Exit
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1 Excel

Schedule 3 0} *

PowerPoint

Select Open with or Save

E;’ Ontario

{E] B R
T o i - =
T |oew S g =

Schedule 3.0 - Allocations fior

You have chosen to open:

] Schedule 3_0.xds

which is a: Microsoft Excel Comma Separated Values File

from: https://test.efis.fma.csc.gov.on.ca

What should Firefox do with this file?

() Openwith | Microsoft Excel (default)

@ Save File

[7] Do this automatically for files like this from now an.

ok || cancel |

The PDF report will be exported to Excel where all the normal excel functionalities can

be used.
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2 Ontari e o S5
a4 r Ontarlo . I g\f‘ear: 2014
5 Cycle: Revised Estimates
6
7

Schedule 3.0 - Allocations for Operating and Other Purposes
10
11
12 Page:Recipient Working Version, Algoma DSAB
13 Allocation
14 Core Service Delivery Operating Allocations
15 1.1 Core Services Delivery 100% o
16 1.2 Core Services Delivery - Cost Share Requirement 80:20 1,416,942
17 13 Core Services Delivery - Cost Share Reguirement 50:50 194,388
18
15 Total Operating Sectors for Allocation Excluding TWOMO (100% Provincial Contribution)
20 (2.1 Language 110,450
21 (22 Aboriginal 5,252
22 [23 Cost of Living 55,181
23 2.4 Rural and Remote 1,787,509
24 25 FDK transition 85,644
25 26 Transformation 11,884
26 (27 Capacity Building 11,785
27 (2.8 Small Water Works 4,125
28 29 Repairs and Maintenance 4 872
29 2.10 Utilization Adjustment 32,702
30 2.1 Capping Adjustment -55,2285]
31
323 Total Operating Sectors for Allocation Excluding TWOMO 3,950,508
33
34 Total Capital Sectors for Allocation
35 (4.1 Capital Retrofits 15,178|
36
375 Total Sectors for Allocation Excluding TWOMO 3,965,635
38
39 (6.1 TWOMO 120,038]
40
mi7 Total Sectors for Allocation 4,085,725
42



6. Submission Management

6.1. Overview of Versions

Submission Management allows you (the “Recipient”) to manage the versions or
submissions that you are working on. The tools provided in EFIS 2.0 give you the ability
to copy data between versions and ultimately to promote the Recipient Working Version
for approval (using the Workflow / Approvals Management process).

### verify versions — still only FA viewable???

Recipient Versions
This version allows the Recipient User to work on their submission by
entering data and running calculations. Although data can be copied to and
from this version, this is the only version which can be verified and promoted
VoW Recipient Working Version *** in the Approvals module.
*** Once the submission has been promoted, the access to this version changes to Versions
READ, meaning that the version cannot be written or copied to Recipient User
can write to
Version for review by FA. The FA does not have access to view Recipient
Working Version. If a Recipient User needs the FA to review the data in that
V10FOV Recipient FA Viewable Version . & P _ ] ey
version for any reason, they would copy the data into "FA Viewable Version”.
This allows for the FA to review and give feedback to the Recipient User.
The final version which is submitted to the Ministry. Once the Recipient User
V10 Recipient Active Version promotes the Recipient Working Version, an approver is responsible for
approving the data and promoting it to the Recipient Active Version.
V10101 Recipient Inactive Version 1
V10102 Recipient Inactive Version 2
V10103 Recipient Inactive Version 3 -
V10104 Recipient Inactive Version 4 o _E_rs'i'”J
V10105 Recipient Inactive Version 5 Versions used as a historical / audit record of previously active versions. ecn:uer;f ser
V10106 Recipient Inactive Version 6 can readtrom
V10107 Recipient Inactive Version 7
V10108 Recipient Inactive Version 8
V10109 Recipient Inactive Version 9
V20 FA Active Version The final version which is submitted by the Ministry for payout purposes.

6.1.1. Copy Data from Working Version to FA Viewable Version

This functionality allows you to copy your current data into a file where your Financial
Analyst will have the ability to go into the file to assist you with any issues you may be
encountering. Please note that your Financial Analyst will not be able to change any of
your data. He/She will simply be able to look at your entered data and guide you along
to help you resolve your problem. You will then have to go back into your Working
Version to make any necessary changes.

These are the steps to copying your data from Working Version to FA Viewable:



1. Under My Task List, open the following task: Submission Management —
Modifier > Submission Management > Copy Data to Recipient FA

Viewable Version

M s - Task st status

Forms

My Task List

] Submission Input and Query_Soumission Entrée et requéte
= i Submission Management - Modifier_Gestion de la soumission - Modificateur
= &) Submission Management
57 ersion Description and Summary
C Copy Data to Recipient FA Viewable Version
57 Flag Submission for Approval
C Validate and Promate for Approval

ol
E Gestion de la soumission

Task List Status

[ Task - Copy Data to Recipient FA Viewable Version-COPY_V10FOV . Task Instructions

#Period: YearTotall | Year: 2014-15 ié_f"Scenario: Finandal Statements
Trainer Recipient - _I

Mo Category

THIS PROCESS WILL REPLACE ALL DATA IN ‘Redpient FA Viewable Version'

WITH DATA FROM 'Recdipient Working Version'. PLEASE CONFIRM

CE PROCESSUS VA REMPLACER TOUTES LES DONNEES dans la Version visible par AF

AVEC LES DONNEES de Version de travail de la destinataire. VEUILLEZ LE CONFIRMER

Are you sure you want to replace all data in FA Viewable Version?
Latest copy date 2015/05/15

Click on the red cell beside “Are you sure you want to replace all data in FA

Viewable Version?”

2. and select “Yes/Oui” from the drop-down

3. Click the Save button

4. A new window will pop up stating that the calculation is in progress

Ver_FA_Viewable in Progress...

5. When the process completes the following message will appear

@ Information Bl

Messages for this page are listed below.
':_D The data has been saved.

=
'.,D Rule was run successfully

Ok




6. The “Latest Copy Date” cell will be updated with today’s date

e g e ———— g ——

e e ——

Latest copy date

2015/05/15

6.2.1. Version Description and Summary Dashboard in the task list

The Version Description and Summary — Submission Dashboard allows you to
keep track of the versions you are working with. It is a place that allows you to see the
current status of your submission (whether it is active or not) and allows you to add
descriptions to each of the Draft versions available. This way, you can know where your
data is currently stored/saved and can easily work on promoting the correct data as part
of the Sign-off and Approvals process. The right hand panel shows the history of the
versions that were activated over time.

ORACLE’ enterprise Performance Management System Workspace, Fusion Edition

Logged in 2 EFIS.TRAINEROIEGMAIL.OOM | Help | Log off

# Forms

My Task List
= I Submission Input and Query_Soumission Entrée ot requite
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H O Fiag 5
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or Approv
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n - Modi

Task List Status

Task - Versi

Task Instructions

2 Year: 2014-15

5, Scenario: Financial Statements o, Period: YearTotall J Category: No Category J SubCategory: No SubCategory
> &
| Submission Status
‘Submission Status | Activation Date| Submission created by TP Activation Datel TP Process Complets
jent Active Version, Nok
V20:FA Active Version Not

Version Description

Activation Dete] Varson Descriptio] T

jent Working Versicn

Add Comments here

k10F0V:Recipient FA Vievable Versio

/20:FA Active Version

sipient Error Override Version

ipient Active Version

V10101 :Recipient Inactive Version 1

Inactive Version 2

ient Inactive Version 3

V10104: Recipient Inactive Version 4

W10105:Recipient Inactive Version 5

Version 6

Version 7

Verscn &

4l Preferences

6.2. Approvals Process —Modifier

Complete [] | Previous Incompiete || Previous

Next Incomplete || Next || Task List Home

The Submission Management task list is used to manage sign-off and approvals as you
complete the cycle. Once your submission is ready for approval, there are a number of
steps to promote the submission.

The first requirement is that all the data that must be submitted must be in “Recipient
Working Version”. This is the only version that can be promoted to the approvals
process which starts off with the Validation of the file.



When all the data in the Recipient Working Version is ready, it is recommended that you
first review and address any Errors and Warnings and Input Validation errors prior to
beginning the Sign-off and Approvals process.

The file validation is initiated and completed by running the following steps:

6.2.1. Flag Submission for Approval

Select Submission Management > Flag Submission for Approval task. In the row
“Are you sure you want to promote the current Submission for approval?” Select “Yes”
from the dropdown menu and click the Save button.

It is very important to note that each time a change is made to your submission after
you have already “flagged” the submission for approval for example you corrected
invalid data, the flag must be re- flagged. This ensures that the most recent data is
being validated.

ORACLE’ Enterprise ion Logged in as EFIS. TRAINEROI@GMAIL.COM | Help | Log OFf

-

Task List Status

Task - Flag Submission for Approval-PROMO | Task Instructions

4, Period: YearTetall % Year: 2014-15 (] Scenario: Financial | Statements ) Category: No Category ) SubCategary: No SubCategary

a0

[ Recipient Wrking Version |

Are you sure you want to promote the current Submission for approval?

ian - Modif

s5abessaly Loepye, ejea )

& I Gestion de la soumission

L Complete [] | Previous Incomplet= || Previous || MextIncomplete || Next || Task List Home

6.2.2. Validate Submission

This process validates your entire file prior to submission. It is here that all remaining
errors and warnings, which were not addressed earlier, will be captured and highlighted
for you to go and correct.

If there are any errors found in your submission, you will not be able to submit your file
to the Ministry. To validate your submission:



Select Submission Management and open the Validate and Promote for Approval

task

= forms
Hy Task Lt
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Select your Recipient name shown under Planning unit and click on Actions >

Validate

ol PLALSISP - Task List Status ¥

+ Forms
Hiy Task (st
¥ s

L]
me
| Adonse  Vaw
Y £ f Apprwosh S Y FubSuha F | Cumest Conar ¥ | Lncatan, | Patn | Do
| = | 1t Sgrad OF MCC M e - i |

Taak List Status
e e ——
wrhing verses [o] | Oe ol ataet
L]
T
o peeren e ¢ ke |CumedOoow ¢ Lecater V| pun | D |
e | e e |
o Prefesences. Cowpisin Pywsicus Incompists || Brevious || Mt Incompiets || fet || Tak Ust pome




As the validation process takes a few moments, you can click on the Refresh button to
refresh the process and see the results. If there are any errors found during the
Validation process, the Sub-Status will be displayed as Invalid Data. When there are no
more validation errors the Sub-Status will display No Additional Approval Required.

ORACLE’ Enterprise ion n Logged in as EFIS.TRAINEROI@GMAIL.COM | Help | Log Off
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# Forms Task List Status

My Task List | Task - Validate and Bromote for Approval-Manage Approvals | Task Instructons

=B - A., e =
[ " Suinwiaan fopimal Croby, Sl Sevie i e iy Scenario | Financial Statements [ | Version | Recipient Working Version ] | Ge O chCffice| A=l
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Select the Invalid Data Hyperlink and a new Task List will appear under My Task List
and will outline all the forms that contain validation errors..
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Selecting the error task in the Task list will take you to the error that needs to be
corrected. In the example below, the user is directed to an Error Form indicating there is
an error on Schedule 2.3. The user must navigate to Schedule 2.3 to remove the error.
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You must locate and correct all validation errors before the Submission can be
successfully promoted.

Once the validation errors have been corrected, you can either rerun the Validation
process to ensure you have not missed any errors or you can move directly to the
Promote process.

NOTE: To continue on with the submission process, after any errors or warnings have
been corrected, you must re-set the Flag Submission for Approval to Yes.
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When the Submission passes the validation, the Sub-Status will be updated to No
Additional Approval Required and the Error Task List will be removed.

The submission is now ready to be Promoted.
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6.2.3. Promote Submission
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To promote the submission to the Recipient Approver, select Submission
Management - Validate and Promote for Approval, and select your Recipient name

under the Planning Unit.
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Once the Recipient name under the Planning Unit is selected, select Actions ->

Change Status.
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The Change Status screen will appear. Select Promote from the Select Action list.

“Select Next Owner” will be pre-populated with Automatic and should remain as is.

Enter comments, if required, then click OK
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The submission will be promoted to your Approver and the Recipient Working Version
will now be changed to a “Read Only” file, that is, you will not longer be able to make

any changes to the file.
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Please note that if you attempt to promote a submission when there are validation
errors, the Sub- Status will be displayed as Failed: Invalid Data. You will be required to
correct the validation errors and then re-do the Promote process.
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6.3.

Manage Approvals —Approver

Once a submission has been promoted by the Modifier, the Modifier no longer has
“write access” to the Working Version and the next user in line is the Approver. The
Approver is responsible for reviewing the submission and deciding how to proceed with

it.

The Approver has two choices:

1. Continue on with the sign-off process of the submission or



2. Reject the submission

If the Approver decides to reject the submission, the submission returns back to the
Modifier to make any necessary adjustments.

If the Approver continues with the sign-off process and approves of the file, the data is
automatically copied from the Recipient Working Version to the Recipient Active
Version.

At this point, you have officially submitted your EFIS file to the Ministry and the status of
the submission is changed to “Active”. Your Financial Analyt will then start the review
process.

6.3.1. Approve and Sign-off

Select Submission Management > Recipient Approver Sign-Off. Within the form
click the dropdown beside “Are you sure you want to sign-off the current submission?”
and select Yes then select Save.
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The status of the Submission will be changed to Active and the Activation date will be
updated.
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6.3.2. Reject and return submission to the Modifier

If the Approver decides that the submission is not acceptable and not ready for sign-off,
the approver can return the submission to the Modifier.

To reject a submission, select Submission Management > Reject Submission
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Once the Recipient name under Planning Unit is selected, select Actions [1 Change
Status.
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The Approvals status will change to Not Signed Off.

The Owner will revert back to the Modifier and the Recipient Working Version will no
longer be read- only, so changes can be made.
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6.3.3. Submission with Error Override

Under special circumstances a Recipient may need to promote a Submission that
contains errors. In these rare instances, the Modifier in the Errors Tab, will set the
Recipients Accepts Error Flag to Yes then follow the normal submission process. In
this case, the data is automatically copied from the Recipients Working Version into the
Recipients Error Override Version. From the perspective of the Approver, the process
follows the exact same steps as outlined in the previous section for a submission
containing no errors.

After the sign-off by Approver, the data still sits in the Recipients Error Override Version.
At this point, additional steps will be required by Ministry personnel. The Ministry needs

to confirm activation of submission with errors. Upon successful completion of this step,
the data is copied from Recipients Error Override into Recipients Active Version and FA
Working Version. Please note that once you have promoted the version with errors you

need to contact the Ministry in order for them to perform the additional steps required.

Select Submission Input and Query = Errors and Warnings Error 2 Errors and
Warnings select Yes from the Recipient Accepts Error drop down list and click Save
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Modifier follows the normal Promotion process.
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The submission owner is now the Approver and the Recipient Working version is
changed to read only
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The Approver follows the normal sign-off process
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The Approver will receive a message that the Submission has been sent to the
Administrator (Ministry) for error override and the submission status will become
Pending Error Override.
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